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Tutorial Outline 
Time (Tentative!) Module Topics Presenter 

8:30-9:00  1. Overview of Eclipse 
     and PTP 

  Introduction to Eclipse/PTP Greg 

9:00-10:00 2. Installation   Prerequisites, Installation Greg 

10:00-10:30 BREAK 

 10:30-11:15 3. CDT: Working with C/C++   Eclipse basics; Creating a new project 
  Building and launching 

Beth 

11:15-12:00 
1:30-2:15 

4. Working with MPI 
(incl. Remote) 

  CVS, Makefiles, autoconf, PLDT MPI tools 
  Resource Managers 
  Launching a parallel application 

Jay 

12:00 - 1:30 Lunch 

2:15-3:00 5. Debugging   Debugging an MPI program Greg 

3:00-3:30 BREAK 

3:30-4:00 6. Fortran; Refactoring   Photran overview; comparison w/ CDT 
  Refactoring support 

Jeff 

4:00 – 4:45  7. Advanced Features: 
Performance Tuning & 
Analysis  Tools 

  PLDT (MPI, OpenMP, UPC tools) (10 min)  
  TAU, ETFw (15), PPW (5) 
  ISP (15) 

Beth 
Wyatt/Max 
Alan 

4:45- 5:00 8. Other Tools, Wrapup   NCSA HPC Workbench,  Other Tools, 
website, mailing lists, future features 

Jay/Beth 



1-0 Module 1 

Module 1: Introduction 

 Objective 
 To introduce the Eclipse platform and PTP 

 Contents 
 What is Eclipse?  
 What is PTP? 
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What is Eclipse? 

 A vendor-neutral open-source workbench for 
multi-language development 

 A extensible platform for tool integration 
 Plug-in based framework to create, integrate 

and utilize software tools 
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Eclipse Platform 

 Core frameworks and services with which all 
plug-in extensions are created 

 Represents the common facilities required by 
most tool builders: 
 Workbench user interface 
 Project model for resource management 
 Portable user interface libraries (SWT and JFace) 
 Automatic resource delta management for 

incremental compilers and builders 
 Language-independent debug infrastructure 
 Distributed multi-user versioned resource 

management (CVS supported in base install) 
 Dynamic update/install service 
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Plug-ins 

  Java Development Tools (JDT) 
  Plug-in Development Environment (PDE) 
  C/C++ Development Tools (CDT) 
  Parallel Tools Platform (PTP) 
  Fortran Development Tools (Photran) 
  Test and Performance Tools Platform (TPTP) 
  Business Intelligence and Reporting Tools (BIRT) 
  Web Tools Platform (WTP) 
  Data Tools Platform (DTP) 
  Device Software Development Platform (DSDP) 
  Many more… 
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Launching & Monitoring 

Eclipse Parallel Tools Platform (PTP)   

Debugging 

Coding & Analysis 

Performance Tuning 

Module 1 
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Parallel Tools Platform (PTP) 

  The Parallel Tools Platform aims to provide a highly 
integrated environment specifically designed for parallel 
application development 

  Features include: 
  An integrated development environment (IDE) that 

supports a wide range of parallel architectures and runtime 
systems 

  A scalable parallel debugger 
  Parallel programming tools  

(MPI/OpenMP) 
  Support for the integration  

of parallel tools 
  An environment that simplifies the  

end-user interaction with parallel systems 
  http://www.eclipse.org/ptp 
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PTP Features Demo… 

  Check out a project from CVS 
  Team features 
  Content assist, searching, include browser 
  Building the project 
  Launching an MPI program 
  Debugging an MPI program 



Module 2: Installation 

 Objective 
 To learn how to install Eclipse and PTP 

 Contents 
 System Prerequisites 
 Software Prerequisites 
 Eclipse Installation 
 PTP Installation 
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About PTP Installation 

 PTP 3.0 isn’t “official” until Nov. 30. 
@SC09 Tutorial: we’re installing a pre-release of PTP 3.0 

 Note: up-to-date info on installing PTP and its 
pre-reqs is available from the release notes: 

http://wiki.eclipse.org/PTP/release_notes/3.0 

  The above information may supersede these slides 
  @SC09 Tutorial: specific instructions will follow, 

referencing files available on USB drive or CD during the 
tutorial  
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System Prerequisites 

 Local system (running Eclipse) 
 Linux (just about any version) 
 MacOSX (10.5 Leopard or 10.6 Snow Leopard) 
 Windows (XP on) 

 Remote system (running/debugging 
application) 
 Must be supported by a resource manager 
 Open MPI 1.2+ 
 MPICH 2 
 IBM PE & LoadLeveler (AIX or Linux) 
 SLURM (Linux) 

Module 2 2-2 



Software Prerequisites 

 Java (1.5 or later) 
 Cygwin or MinGW (for local development on 

Windows) 
 Unix make or equivalent 
 Supported compilers (gcc, gfortran, Intel, etc.) 
 Gdb for debugging (or a gdb-like interface) 
 Gcc for building the debugger and SLURM 

proxies from source 
 IBM C for building the PE/LoadLeveler proxies 

from source 
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Java Prerequisite  

 Eclipse requires Sun or IBM versions of Java 
 Only need Java runtime environment (JRE) 
 Java 1.5 is the same as JRE 5.0 
 The GNU Java Compiler (GCJ), which comes 

standard on Linux, will not work! 

Module 2 2-4 



Eclipse and PTP Installation 

  Eclipse is installed in two steps 
  First, the base Eclipse package is downloaded and 

installed 
  Additional functionality is obtained by adding 

‘features’ 
  This can be done via an `update site’ that 

automatically downloads and installs the features 
  Update site archives can be downloaded to install 

features offline. 

  PTP requires the following Eclipse features 
  C/C++ Development Tools (CDT) 
  Remote Systems Explorer (RSE) end-user runtime 

  Required only if you are remotely developing 
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Eclipse Packages 

 Eclipse is available in a number of different 
packages for different kinds of development 

 Two packages are more relevant for HPC: 
 Eclipse Classic  

 The full software development kit (SDK), including 
Java and Plug-in development tools 

 Eclipse IDE for C/C++ developers  
 Base Eclipse distribution 
 Base C/C++ Development Tools (CDT)  

(does not include UPC, but it can be added) 
 Smaller and less cluttered than full SDK 

 Either is fine for PTP use 
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Eclipse Installation 

 The current version of Eclipse is 3.5.1 (Galileo) 
 PTP 3.0 will only work with this version 

 Eclipse is downloaded as a single zip or 
gzipped tar file from 
http://eclipse.org/downloads 
@SC09 Tutorial: available on USB or CD. 

 You must download the correct version to suit 
your local environment 
 Must have correct operating system version 
 Must have correct window system version 

 Unzipping or untarring this file creates a 
directory containing the main executable 
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Eclipse Installation Files 

Install from one of these files, depending on your 
platform, and SDK or C/C++ version: 

  eclipse-SDK-3.5.1-win32.zip 
  eclipse-SDK-3.5.1-macosx-cocoa[-x86_64].tar.gz 
  eclipse-SDK-3.5.1-linux-gtk[-x86_64].tar.gz 

  eclipse-cpp-galileo-SR1-win32.zip 
  eclipse-cpp-galileo-SR1-linux-gtk[-x86_64].tar.gz   
  eclipse-cpp-galileo-SR1-macosx-cocoa.tar.gz 

Unzip or untar on your machine.  
Creates ‘eclipse’ directory containing executable 
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Starting Eclipse 
  Linux 

  From a terminal window, enter 

  MacOS X 
  From finder, open the eclipse folder where you installed 
 Double-click on the Eclipse application 
 Or from a terminal window 

  Windows 
 Open the eclipse folder 
 Double-click on the eclipse executable 

  Accept default workspace when asked 
  Select workbench icon from welcome page 

<eclipse_installation>/eclipse/eclipse & 
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Specifying A Workspace 

The prompt can be 
turned off 

 Eclipse prompts for a workspace location at 
startup time 

 The workspace contains all user-defined data 
  Projects and resources such as folders and files 
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Eclipse Welcome Page 

 Displayed when Eclipse is run for the first time 

Select “Go to the workbench” 
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Adding Features 

  New functionality is added to Eclipse using features 
  Features are obtained and installed from an update site 

(like a web site) 
  Features can also be installed from a local copy of the 

update site (which can be zipped archives)  
  allows for offline installation  
 @SC09 Tutorial: we will install from archived update sites 
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Installing Eclipse Features 
from an Update Site 

  Three types of update sites 
 Remote - download and install from remote server 
  Local - install from local directory 
 Archived - a local site packaged as a zip or jar file 

  Eclipse 3.5 comes preconfigured with a link to the Galileo 
Update Site 
  This is a remote site that contains a large number of official 

features 
 Galileo projects are guaranteed to work with Eclipse 3.5 

  Many other sites offer Eclipse features 
  Use at own risk 
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Installing from an Update Site 
  From the Help menu, choose  

      Install New Software… 
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Galileo Update Site 
  The Galileo site comes 

already configured with Eclipse 

  For example, some of the  
contents of the Galileo site: 

  You can get C/C++ Dev. Tools 
from the Galileo site, but… 

  Basic tools only, does not include UPC  
  More complete CDT install 

shown later 
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Installation: CDT 

 If you installed Eclipse classic (full SDK) 
 you will now need to install CDT. 

 If you installed the C/C++ IDE instead 
 You will need to update CDT to get 6.0.2 

(required for PTP 3.0) 
 You may want to install other features too,  

for example: the UPC feature. 
The C/C++ IDE includes only the most basic CDT 
features. 
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Installation: CDT (2) 
  PTP 3.0 needs CDT 6.0.2  

  Update site contains only 6.0.1 as of this writing 

  Update site: http://download.eclipse.org/tools/cdt/releases/galileo 
  CDT 6.0.2 archived update site file  

is available from: 
download.eclipse.org/tools/cdt/builds 
@SC09 Tutorial:  
Add…  Archive… cdt-master-6.0.2*.zip 

  Install any features you want 
  Suggestion: install everything but: 

Omit the testing feature: 

  This includes the UPC feature (optional) 
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Installation: CDT (3) 

 Finish installing CDT: 
 Next, Confirm features, Next, Accept license terms, 

Finish 

 You do not  need to restart Eclipse, since we 
will now install RSE and PTP. 
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Installation: RSE 
 Again: Help > Install New Software… 
 The RSE End-User Runtime can be installed 

from the Galileo update site 

@SC09 Tutorial: Use archived update site 
Add… Archive…   choose  rse-3.1-updateSite.zip file 

  Choose TM and RSE 3.1.1 / RSE End-User Runtime 
  If it tries to install 3.1.0 also, uncheck it and hit Next > 
  Accept license terms etc., no need to restart yet 
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Installing PTP 
  Help > Install New Software    hit Add… 
  PTP update site:  

http://download.eclipse.org/tools/ptp/releases/galileo/ 
@SC09 Tutorial: Select Archive… 
and enter ptp-master-*.zip 

  Click OK and the list of features 
on the update site will be 
populated 

  Select all the components you require. 
Suggestion: select only “Parallel Tools  
Platform 3.0” 
@SC09 Tutorial:  
Omit Remote Development Tools 

  Click Next>, Next>, Finish 
  Select Yes to restart Eclipse now 

See PTP release notes for most 
recent info on installing 3.0 
http://wiki.eclipse.org/PTP/release_notes/3.0 
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Installing PTP (2) 
  After selecting Finish… 

  Restart Eclipse when prompted 

  Select OK when Eclipse restarts, to use the same 
workspace  
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Restarting Eclipse 

Yellow 
indicates new 
features just 
installed 

  Welcome page 
informs you of 
new features 
installed 

  Select 
workbench icon 
to go to 
workbench 

Go to 
workbench 
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Installing Additional PTP Components 

 PTP has a number of additional components 
depending on the installation 
 Scalable Debug Manager (SDM) – required for all 

platforms to support debugging 
 PE and LoadLeveler proxy – IBM systems only 
 SLURM proxy – systems using the SLURM resource 

manager 

 Installation of these components is beyond the 
scope of the tutorial 

 See the release notes for details of installing 
these components 
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Platform Differences 

 Single button mouse (e.g. MacBook) 
 Use Control-click for right mouse / context menu 

 Context-sensitive help key differences 
 Windows: use F1 key 
 Linux: use Shift-F1 keys 
 MacOS X 

 Full keyboard, use Help key 
 MacBooks or aluminum keyboard, create a key binding 

for Dynamic Help to any key you want 

 Accessing preferences 
 Windows & Linux: WindowPreferences… 
 MacOS X: EclipsePreferences…
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Module 3: Working with C/C++ 

 Objective 
 Learn how to use Eclipse to develop C programs 
 Learn how to launch and run a C program 

 Contents 
 Brief introduction to the C/C++ Development Tools 

(CDT) 
 Create a simple application 
 Learn to launch a C application 
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Installation recap 

 Download and unzip/untar eclipse 
 Use  Help >Install new software -- to get 

 CDT for C/C++ tools 
 PTP and related tools for Parallel application work * 

 Build PTP binary on target machine (local or 
remote) * 

 Only required if running parallel apps locally 

 Launch eclipse! 
Run the ‘eclipse’ executable, from icon or from 
command line 

Module 3 

* Not required for this module 
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Workbench 
 A Workbench contains perspectives 
 A Perspective contains views and editors 

perspective 
Module 3 

view 
view 

view 

editor 

  The Workbench represents 
the desktop development 
environment 
  Contains a set of tools  

for resource mgmt 
  Provides a common way 

of navigating through  
the resources 

  Multiple workbenches  
can be opened at the 
same time 
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Perspectives 

 Perspectives define the layout of views in the 
Workbench 

 They are task oriented, i.e. they contain 
specific views for doing certain tasks: 
 There is a Resource Perspective for manipulating 

resources 
 C/C++ Perspective for manipulating compiled code  
 Debug Perspective for debugging applications 

  You can easily switch between perspectives 
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Switch to C/C++ Perspective 
 Only needed if 

you’re not 
already in the 
perspective 

 What Perspective 
   am in in? 
   See Title Bar 
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Switching Perspectives 

 You can switch 
Perspectives by: 

 Choosing the 
WindowOpen 
Perspective menu 
option 

 Clicking on the 
Open Perspective 
button 

 Clicking on a 
perspective shortcut 
button 

Module 3 3-5 



Views 

 The workbench window is  
divided up into Views 

 The main purpose of a view is: 
 To provide alternative ways of presenting information 
 For navigation 
 For editing and modifying information  

 Views can have their own menus and toolbars 
 Items available in menus and toolbars are  

available only in that view 
 Menu actions only  

apply to the view 

 Views can be resized 

view 

view view 
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Stacked Views 

 Stacked views appear as tabs 
 Selecting a tab brings that view to the 

foreground 
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Help 

  Access help 
  HelpHelp Contents 
  HelpSearch 
  HelpDynamic Help 

  Help Contents provides 
detailed help on different 
Eclipse features 

  Search allows you to 
search for help locally, or 
using Google or the Eclipse 
web site 

  Dynamic Help shows help 
related to the current 
context (perspective, view, 
etc.) 
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Preferences 
  Eclipse Preferences allow customization of almost everything 

 Open  
WindowPreferences… 
 C/C++ preferences allow many 
                         options 

  Code formatting 
       settings  
   (“Code Style”) 
       shown here 
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Creating a C/C++ Application 

Steps: 
 Create a new C project 
 Edit source code 
 Save and build 
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New C Project Wizard 

Create a new C project 
  FileNewC Project 

(see prev. slide) 
  Name the project   

‘MyHelloProject’  
  Under Project types, under 

Executable,  select Hello 
World ANSI C Project 
      (no makefile req’d) 
 and hit Next 

  On Basic Settings page, 
fill in information for your 
new project (Author 
name etc.) and hit Finish 

Module 3 

This  is a  
“Managed Build” 
project 

Makefile project; 
provide your 
own makefile 
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  Open the project properties 
by right-mouse clicking on 
project and select 
Properties  

  Expand C/C++ Build 
  Select Settings 
  Select C Compiler to change 

compiler settings 
  Select C Linker to change 

linker settings 
  It’s also possible to change 

compiler/linker arguments 
  Hit OK to close 

Changing the C/C++ Build 
Settings Manually 
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Editor and Outline View 
  Expand project 

to see source code 
  Double-click on 

source file in the 
Project Explorer 
to open C editor 

  Outline view is 
shown for file in 
editor 

  We’ll describe the 
editor in the  
next few slides… 
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Project Explorer View 

 Represents user’s data 
 It is a set of user defined 

resources 
 Files 
 Folders 
 Projects 

 Collections of files and 
folders 

 Plus meta-data 

 Resources are visible in 
the Project Explorer View 
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Editors 

  An editor for a resource (e.g. a file)  
opens when you double-click on  
a resource 

  The type of editor depends on the type of the resource 
  .c files are opened with the C/C++ editor 
  Some editors do not just edit raw text 

  When an editor opens on a resource, it stays open across 
different perspectives 

  An active editor contains menus and toolbars specific to that 
editor 

  When you change a resource, an asterisk on the editor’s 
title bar indicates unsaved changes 

  How to Save 

editor 
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Source Code Editors 

  A source code editor is a 
special type of editor for 
manipulating source 
code 

  Language features are 
highlighted 

  Marker bars for showing 
  Breakpoints 
  Errors/warnings 
  Task Tags, Bookmarks 

  Location bar for 
navigating to interesting 
features in the entire file 

Icons: 
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  Hover over a program 
element in the source file to 
see additional information 

Content Assist 

  Type an incomplete function name e.g. ”get" into the editor, 
and hit ctrl-space  

  Select desired completion value with cursor or mouse 
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Build 

 Your program should build when created. 
 To rebuild, many ways include: 

 Select project, Hit hammer icon in toolbar 
 Select project, Project  Build Project 
 Right mouse on project, Clean Project 
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Build (2) 

 See the results of the build in the Console View 
 Executable should 

be in Debug folder: 
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Build problems? 

 If there are problems, see: 
 Marker on editor line 
 Problems view  

 Double-click on 
line in Problems 
view to go to 
location of error 
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Build problems? Try it 

 Remove a semicolon from a line 
in your “Hello World” example 

 Save file 
 Rebuild  
 See the  

Problems view  
 Double-click on line in  

Problems view to go to 
location of error 

 Fix it and rebuild to  
continue 
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Run 

 To run your C program, 
 Create a launch configuration 

(see next slide) 
 This saves the run/launching information and 

can be used to quickly run your program 
each time, with and without debug. 
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  Open the run  
configuration  
dialog Run 
Run Configurations… 

  Select C/C++ 
Application 

  Select the New  
button  

Create a Launch Configuration 
a.k.a. Run Configuration 

Depending on which flavor of Eclipse you 
installed, you might have more choices in 
Application types. 
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Complete the Main Tab 

  Ensure that the correct 
project is selected 

  Select the C/C++ 
Application (executable) if 
necessary 
  Search Project… will search 

just within the project 
  Browse will search anywhere 

on the local file system 

  Select Connect process 
input/output to a 
terminal if desired   
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Complete the Arguments Tab 

  Enter any program 
arguments into the text box 

  Eclipse variables can also be 
passed using the 
Variables… button 

  Select a different working 
directory if desired 

Module 3 3-25 



Complete the Debugger Tab 

  Select Debugger tab 
  Make sure gdb/mi is 

selected 
  Change where the 

program should stop if 
desired 

  Change any gdb-specific 
options if desired 
(advanced users only) 

The information on the 
debugger tab will only be 
used for a debug launch 

  Hit the Run button to  
launch your program 
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Viewing Program Output 

  When the program runs, the Console view should automatically 
become active 

  Any output will be displayed in this view (stderr in red) 
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Debug your code 
 Launch with same config 

used for Run 
 If asked, you can set: 

 Preferred Launcher: Standard 
 Use Config-specific or 

change Workspace setting 
 Debugger: gdb/mi  

 Eclipse asks to switch 
to Debug Perspective 

 Select Yes  to continue 

Module 3 

Run 

Debug 
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detail when we cover parallel debugging 



Debug your code (2) 

 Upon launch, Eclipse switches to  
Debug Perspective 

 Program stops at main 
 Set Breakpoint by double-clicking  

in editor left margin  

 Step with F5 or 
 Run with F8 or  
 Hit Breakpoint; inspect variables; inspect stack 
 End with Terminate, or run to end of Prog  

Module 3 

Run/Resume Step Over 

Terminate 

Breakpoint 
Marker 
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Other CDT features 

 Searching 
 Open Declaration / hyperlinking between files 

in the editor 
 Rename in file (in-place in editor) 
 Refactoring 

 Rename refactoring / Preview panes 
 Extract Constant refactoring 
 Other refactorings in CDT 
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Language-Based Searching 

  “Knows” what things can 
be declared in each 
language (functions, 
variables, classes, 
modules, etc.) 

  E.g., search for every call 
to a function whose name 
starts with “get” 

  Search can be project- or 
workspace-wide 
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Open Declaration 

  Jumps to the declaration 
of a variable, function, 
etc., even if it’s in a 
different file 

  Right-click on an identifier 
  Click Open Declaration 

  Can also Ctrl-click (Mac: 
Cmd-click) to 
“hyperlink” to declaration 
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In Java (Murphy-Hill et al., ICSE 2008): 

Rename Refactoring 
 Changes the name of a variable, function, etc., 

including every use 
(change is semantic, not textual, and can be workspace-wide) 

 Only proceeds if the new name will be legal 
(aware of scoping rules, namespaces, etc.) 

  Select C/C++ Perspective 
  Open a source file 
  Click in editor view on declaration of 

a variable 
  Select menu item 

RefactorRename 
 Or use context menu 

  Enter new name 
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CDT Rename in File 

  Position the caret 
over an identifier. 

  Press Ctrl+1 
(Command+1 on Mac). 

  Enter a new name.  
Changes are 
propagated within 
the file as you type. 
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CDT Extract Constant Refactoring 

 Other refactorings 
that are planned: 

  Extract Function 
  Hide Member Function 
  Move Field or Member Function 
  Extract Subclass 
  Extract Baseclass 
  Separate Class 
  Implement Function 
  Declare Function 
  Move Function Definition 
  Generate Getters and Setters 
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Module 4: Working with MPI 
 Objective 

 Learn how to use a source code repository (CVS) 
 Learn how to develop, build and launch an MPI 

program on a remote parallel machine 

 Contents 
 Using a version control system (CVS)   
 Remote project setup 
 Building with Makefiles and autoconf 
 MPI assistance features   
 Working with resource managers 
 Launching a parallel application 
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Userids for PTP Tutorial 

 The hands on portion of this module will be 
done on a remote system 
(abe.ncsa.uiuc.edu) at NCSA  

  http://www.ncsa.illinois.edu/UserInfo/Resources/
Hardware/Intel64Cluster/ 

 Login information provided at the beginning 
of the tutorial 
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 Configuring version control 
 Checking out the source code 
 Team support 

Creating the Project 
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Connecting to a Repository 
  Select WindowOpen 

PerspectiveOther… 
  Select CVS Repository 

Exploring then OK 
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Specify Repository Location 
  Right-click in the CVS 

Repositories view, then select 
NewRepository Location… 

  Set Host to the hostname of 
remote machine 

  Set Repository path to the CVS 
repository path 

  Fill in Username and Password 
  Set Connection type to extssh 

to use an ssh connection 
  For anonymous access, use 

pserver connection type 
  Check Save password if you 

wish to save the password 
  Select Finish 
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CVS Repository Exploring 
  Open the repository in 

the CVS Repository 
view 

  Open HEAD to view 
files and folders in the 
CVS head 

  Open Branches or 
Versions to view CVS 
branches or versions 
respectively 

  Right-click on the 
repository and select 
Refresh Branches… 
to see all branches and 
versions 
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Checking out code in Eclipse 
  If the project exists in the repository 

as an Eclipse Project, then one can 
simply “Check Out” the code 

  In CVS Repositories view, right-click 
on project and select 
ProjectCheck Out 

  Our example doesn’t have Eclipse 
Project information – this code was 
checked in with command line tools. 

  Our next slide shows how to add 
Eclipse Project information 
automatically as you check out the 
code. 
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Check out as an Eclipse Project 
  In CVS Repositories view, right-click 

on project and select 
ProjectCheck Out As… 

  Make sure Check out as a project 
configured using the New Project 
Wizard is selected 

  Leave Checkout subfolders 
checked 

  Select Finish 

The wizard that runs next 
will add Eclipse information  
to the project. 
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New Project Wizard: 
Create a C Project 

  The New Project Wizard is used 
to create a C project 

  Enter Project name 
  Under Project Types, select 

Makefile projectEmpty 
Project 
  Ensures that CDT will use existing 

makefiles 

  Select Finish 
  When prompted to switch to the 

C/C++ Perspective, select Yes 
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Added by PLDT (Parallel Lang. Dev. Tools) 
feature of PTP 

 MPI Context sensitive help 
 MPI artifact locations 
 MPI barrier analysis 
 MPI templates 

 For this part, use the local project that you 
created from CVS. 

MPI Assistance Tools 

Module 4 4-9 



4-10 

Set MPI Preferences 
  To run MPI analysis, you first 

need to tell PLDT what an MPI 
API is, by locating the MPI 
include files. 

  Open Preferences 
Window > Preferences 
Mac: Eclipse > Preferences 

  On the MPI Preferences page, 
add a new MPI include path: 

  New … and point to the 
directory containing your MPI 
header file 

  Select OK 
  Back on New Project Wizard 

page, select Finish. 
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Edit aids to MPI development 

  Helpful editor features: 
  Code completion 

(Ctrl-space) 
  Hover over MPI API 
  Help (see next slide) 

Module 4 4-11 



4-12 

Context Sensitive Help 
  Click mouse, then press help 

key when the cursor is within a 
function name 
  Windows: F1 key 
  Linux: ctrl-F1 key 
  MacOS X: Help key or 

HelpDynamic Help 
  A help view appears (Related 

Topics) which shows 
additional information 
(You may need to click on MPI 
API in editor again, to 
populate) 

  Click on the function name to 
see more information 

  Move the help view within your 
Eclipse workbench, if you like, 
by dragging its title tab 
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Show MPI Artifacts 
  Select source file; Run 

analysis by clicking on 
drop-down menu next to 
the analysis button and 
selecting Show MPI 
Artifacts 

  Markers indicate the 
location of artifacts in 
editor 

  In MPI Artifact View 
sort by any column (click 
on col. heading) 

  Navigate to source code 
line by double-clicking on 
the artifact 

  Run the analysis on 
another file (or entire 
project!) and its markers 
will be added to the view 

  Remove markers via  
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MPI Barrier Analysis 
Verify barrier 
synchronization in C/MPI 
programs 

Interprocedural static 
analysis  outputs: 

 For verified programs, 
lists barrier statements that 
synchronize together 
(match) 
  For synchronization 
errors, reports counter 
example that illustrates and 
explains the error  
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MPI Barrier Analysis – Try it   

Module 4 4-15 

Run the Analysis: 
 In the Project Explorer, 
Select the shallow project  
to analyze  

  Select the MPI Barrier 
Analysis action in the menu 

 Found 
two 
barriers 
 Barrier 
matches 
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MPI Barrier Analysis - views 

MPI Barriers view 

Simply lists the barriers 

Like MPI Artifacts view, 
double-click to navigate 
to source code line (all 
3 views) 

Barrier Matches view 
Groups barriers that 
match together in a 
barrier set – all 
processes must go 
through a barrier in the 
set to prevent a 
deadlock 

Barrier Errors view  

If there are errors, a 
counter-example 
shows paths with 
mismatched number 
of barriers  

Module 4 4-16 



4-17 

MPI Templates 

 Allows quick entry of 
common patterns in MPI 
programming 
 Example: MPI send-
receive 
 Enter: mpisr <ctrl-
space> 
 Expands to 

 Eclipse preferences: add more! 
 C/C++ > Editor > Templates 

 Extend to other common patterns 
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Building the Application 

 Configuring the project build directory 
 Generating Makefiles 
 Creating a Make Target 
 Running the build 
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Makefile Project 

 Similar to managed project, but uses custom 
Makefile (or other script) to control build 

 User can specify command that will be used to 
initiate build 

 Can also specify the directory in which the 
build will take place 

 “Make targets” are used to control type of 
build 

 Can switch between managed and un-
managed project 
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Makefile Project Properties 

  Right click on project in 
Project Explorer to 
bring up properties 

  Click on C/C++ Build 
for the build settings 

  Can change build 
command if desired 

  Can change the Build 
location if it is not the 
top level 
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About Makefiles and autoconf 

  Autoconf is a GNU utility often used to create Makefiles 
for open source projects 
  Used to generate a configure script 
  Configure is run to generate a Makefile that suits a 

particular system configuration 
 Normally only needs to be run once, unless the build 

process needs to be changed 

  Run configure using two methods: 
  Manually from an external shell 
  By creating an External Tools Launch Configuration 

  Must refresh Project Explorer whenever file system is 
modified outside of Eclipse, such as after running 
configure
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Generate the Makefiles 
  From the Run menu, select 

External ToolsExternal 
Tools Configurations… 

  Create a new Program 
  For Location, click Browse 

Workspace… and find the 
configure script 

  For Working Directory, 
click Browse Workspace… 
and select the project 

  Click Run and you should 
see output in the Console 
view 

  In Project Explorer, right-
click and select Refresh to 
see the new files that have 
been created 
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Create a Make Target 
  Select the project in 

Make Targets view 
  Click on New Make 

Target icon 
  This will add a user interface 

to the targets that already 
exist in the Makefile 

  Enter the name of the 
target, in this case “all” 

  If you need to change the 
build command, do it here 
for only this target, or in 
the build properties for all 
targets. 

  Select OK 
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Running the Build 
  Open the project in the 

Make Targets view to 
see the all target 

  Double-click on the all 
target to initiate the build 

  Output from the build will 
be visible in the Console 
view 
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Running the Program 
 Creating a resource manager 
 Starting the resource manager 
 Creating a launch configuration 
 Launching the application 
 Viewing the application run 
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Local vs. Remote 
 PTP allows the program to be run locally if you 

have MPI installed 
 However we want to run the program on a 

remote machine 
 Need to either cross-compile (hard to 

configure) or compile remotely 
 Remote compiling will be available in the 3.0 

release 
 Will be demonstrated later 

 For the tutorial, we have pre-compiled the 
program on the remote machine 
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Terminology 

 The PTP Runtime perspective is provided for 
monitoring and controlling applications 

 Some terminology 
 Resource manager - Corresponds to an instance of 

a resource management system (e.g. a job 
scheduler). You can have multiple resource mangers 
connected to different machines. 

 Queue - A queue of pending jobs 
 Job – A single run of a parallel application 
 Machine - A parallel computer system 
 Node - Some form of computational resource 
 Process - An execution unit (may be multiple 

threads of execution) 
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Resource Managers 

 PTP uses the term “resource manager” to refer to any 
subsystem that controls the resources required for 
launching a parallel job.  

 Examples:  
 Job scheduler (e.g. LoadLeveler) 
 Open MPI Runtime Environment (ORTE) 

 Each resource manager controls one target system 
 Resource Managers can be local or remote 
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About PTP Icons 

  Open using legend icon in 
toolbar 
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Open PTP Runtime Perspective 
Window > Open Perspective > Other… 
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PTP Runtime Perspective 

Resource 
managers 
view 

Machines 
view 

Node details    
view 

Jobs view 
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Console 
view 

Properties 
view 
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Adding a Resource Manager 

  Right-click in Resource 
Managers view and select 
Add Resource Manager 

  Choose the Open MPI 
Resource Manager 
Type 

  Select Next> 
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Configure the Remote Location 
  Choose Remote Tools for 

Remote service provider 
  Choose Remote location or 

click New… to create a new 
location 
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Create a New Location 
  Enter a name for the 

connection 
  Can be any string 

  Select Remote host 
  Enter the Host name 
  Enter the User name 
  Select Password based 

authentication 
  Enter the Password 
  Click Finish 
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Configure Tunneling 
  Some remote service 

providers support tunneling 
over ssh connections (e.g. 
Remote Tools) 

  The port forwarding option 
would be enabled this if it 
was available 

  Select Use port 
forwarding so all 
communication will be sent 
over the tunnel 
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Configure the Remote Location (RSE) 
  Choose RSE for Remote 

service provider 
  Choose Remote location or 

click New… to create a new 
location 
  Local can be used to run 

applications locally 
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Create a New Location (RSE) 
  Choose SSH Only for this 

connection 
  Click Next> 
  Enter Host name of remote 

system 
  Click Finish 
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Configure the Resource Manager 

Module 4 4-38 

  The Open MPI resource 
manager will auto detect 
the version and use the 
appropriate commands 
  Change only if you’re an 

expert 
  Set the location of the 

“mpirun” command if it is 
not in your path 

  Click Next> 
  Change the Name or 

Description of the 
resource manager if you 
wish 

  You can also set the 
resource manager to 
automatically start 

  Click Next> 
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Save the Service Configuration 
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  Resource manager 
configuration details are kept 
in a “service configuration” 
along with other configuration 
information 

  The details can be kept in a 
new configuration, or added 
to an existing configuration 

  In this example, we create a 
new service configuration 

  Use a name that describes the 
purpose of the configuration 

  Click Finish 
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Starting the Resource Manager 

  Right click on new 
resource manager and 
select Start resource 
manager 

  If everything is ok, you 
should see the resource 
manager change to green 

  If something goes wrong, 
it will change to red 
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System Monitoring 

  Machine status shown in 
Machines view 

  Node status also shown 
Machines view 

  Hover over node to see 
node name 

  Double-click on node to 
show attributes 
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  Open the run  
configuration  
dialog Run 
Run Configurations… 

  Select Parallel 
Application 

  Select the New  
button  

Create a Launch Configuration 

Depending on which flavor of Eclipse you 
installed, you might have more choices in 
Application types. 
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Complete the Resources Tab 

  In Resources tab, 
select the resource 
manager you want to 
use to launch this job 

  Enter a value  
in the Number of 
processes field 

  Other fields can be 
used to specify 
resource manager-
specific information 
  E.g. specify By node 

to allocate each 
process to a different 
node 
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Complete the Application Tab 

  Select the 
Application tab 

  Choose the 
Application program 
(executable) by 
clicking the Browse 
button 

  Navigate to the 
executable location (in 
this case on the 
remote machine) 

  Display combined 
output in a console 
view will show 
program output in a 
console view 
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Viewing The Run 

  Double-click a 
node in machines 
view to see which 
processes ran on 
the node 

  Hover over a 
process for tooltip 
popup 

  Job status and 
information 
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Viewing Program Output 

  Console displays 
combined output 
from all processes 

  Properties view 
shows job details 
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Remote Projects (RDT) 

  Source located on remote machine 
  Local Eclipse installation is used for: 

  Editing 
  Building 
  Running 
  Debugging 

  Source indexing is performed on remote machine 
  Enables call hierarchy, type hierarchy, include browser, search, 

outline view, and more… 

  Builds are performed on remote machine 
  Supports both managed and unmanaged projects 

  Application is run and debugged remotely using the PTP 
resource managers 
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Remote Project Demo… 

  Create a remote project from existing source 
  Show editing remote files 
  Show outline and include browser 
  Show remote build 

  Limitations: 
  Can’t be used with CVS 
  Only supports fully remote source 
  Partial remote (synchronize) may be added in the future 
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Module 5: Parallel Debugging 

 Objective 
 Learn the basics of debugging parallel programs with 

PTP 

 Contents 
 Launching a parallel debug session 
 The PTP Debug Perspective 
 Controlling sets of processes 
 Controlling individual processes 
 Parallel Breakpoints 
 Terminating processes 
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Launching A Debug Session 

  Use the drop-down next to 
the debug button (bug 
icon) instead of run button 

  Select the project to launch 
  The debug launch will use 

the same number of 
processes that the normal 
launch used 

  First, select Debug 
Configurations… to verify 
the debugger settings 
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Verify the Debugger Tab 

  Select Debugger tab 
  Make sure SDM is 

selected in the 
Debugger dropdown 

  Use the Browse 
button to select the 
debugger executable 
if required 
  If launching remotely, 

the debugger 
executable must also 
be located remotely 

  Debugger session 
address should not 
need to be changed 

  Click on Debug to 
launch the program 
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  Parallel Debug 
view shows job 
and processes 
being debugged 

  Debug view shows 
threads and call 
stack for individual 
processes 

  Source view 
shows a current 
line marker for all 
processes 

The PTP Debug Perspective (1) 
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The PTP Debug Perspective (2) 

  Breakpoints view 
shows breakpoints 
that have been set 
(more on this later) 

  Variables view 
shows the current 
values of variables 
for the currently 
selected process in 
the Debug view  

  Outline view (from 
CDT) of source 
code 
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Stepping All Processes 

  The buttons in the 
Parallel Debug View 
control groups of 
processes 

  Click on the Step Over 
button 

  Observe that all process 
icons change to green, 
then back to yellow 

  Notice that the current 
line marker has moved to 
the next source line 
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Stepping An Individual Process 
  The buttons in the 

Debug view are used 
to control an 
individual process, in 
this case process 0 

  Click the Step Over 
button 

  You will now see two 
current line markers, 
the first shows the 
position of process 0, 
the second shows the 
positions of processes 
1-3 
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Process Sets (1) 

  Traditional debuggers apply operations to a single 
process 

  Parallel debugging operations apply to a single process 
or to arbitrary collections of processes  

  A process set is a means of simultaneously referring to 
one or more processes 
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Process Sets (2) 

  When a parallel debug session is first started, all 
processes are placed in a set, called the Root set  

  Sets are always associated with a single job 
  A job can have any number of process sets 
  A set can contain from 1 to the number of processes in 

a job 
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Operations On Process Sets 

  Debug operations on the 
Parallel Debug view 
toolbar always apply to the 
current set: 
  Resume, suspend, stop, 

step into, step over, step 
return 

  The current process set is 
listed next to job name 
along with number of 
processes in the set 

  The processes in process 
set are visible in right hand 
part of the view 

Root set = all 
processes 
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Create set Remove  
from set 

Delete 
set 

Change 
current set 

Managing Process Sets 

  The remaining icons in the toolbar of the Parallel 
Debug view allow you to create, modify, and delete 
process sets, and to change the current process set 
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Creating A New Process Set 
  Select the processes 

you want in the set by 
clicking and dragging, 
in this case, the last 
three 

  Click on the Create 
Set button 

  Enter a name for the 
set, in this case 
workers, and click OK 

  You will see the view 
change to display only 
the selected processes 
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Stepping Using New Process Set 
  With the workers set 

active, click the Step 
Over button 

  You will see only the 
first current line 
marker move 

  Step a couple more 
times 

  You should see two line 
markers, one for the 
single master process, 
and one for the 3 
worker processes 
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Process Registration 

 Process set commands apply to groups of 
processes 

 For finer control and more detailed 
information, a process can be registered and 
isolated in the Debug view 

 Registered processes, including their stack 
traces and threads, appear in the Debug view 

 Any number of processes can be registered, 
and processes can be registered or  
un-registered at any time 
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Registering A Process 
  To register a process, 

double-click its process 
icon in the Parallel 
Debug view or select a 
number of processes and 
click on the register 
button 

  The process icon will be 
surrounded by a box and 
the process appears in 
the Debug view 

  To un-register a process, 
double-click on the 
process icon or select a 
number of processes and 
click on the unregister 
button 

Individual 
(registered) 
processes 

Groups (sets) 
of processes 
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Current Line Marker 

 The current line marker is used to show the 
current location of suspended processes 

 In traditional programs, there is a single 
current line marker (the exception to this is 
multi-threaded programs)  

 In parallel programs, there is a current line 
marker for every process 

 The PTP debugger shows one current line 
marker for every group of processes at the 
same location 

5-15 



Module 5 

Multiple processes marker  

Registered process marker 

Un-registered process marker 

Colors And Markers 

  The highlight color depends on 
the processes suspended at 
that line: 
  Blue: All registered process(es) 
  Orange: All unregistered 

process(es) 
  Green: Registered or unregistered 

process with no source line (e.g. 
suspended in a library routine) 

  The marker depends on the 
type of process stopped at that 
location 

  Hover over marker for more 
details about the processes 
suspend at that location 
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  Apply only to processes in the particular set that is 
active in the Parallel Debug view when the breakpoint 
is created 

  Breakpoints are colored depending on the active 
process set and the set the breakpoint applies to: 
 Green indicates the breakpoint set is the same  

as the active set. 
  Blue indicates some processes in the breakpoint set are 

also in the active set (i.e. the process sets overlap)  
  Yellow indicates the breakpoint set is different from the 

active set (i.e. the process sets are disjoint) 
  When the job completes, the breakpoints are 

automatically removed 

Breakpoints 
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Creating A Breakpoint 
  Select the process set that 

the breakpoint should apply 
to, in this case, the workers 
set 

  Double-click on the left edge 
of an editor window, at the 
line on which you want to set 
the breakpoint, or right click 
and use the Parallel 
BreakpointToggle 
Breakpoint context menu 

  The breakpoint is displayed 
on the marker bar 
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Module 5 

Hitting the Breakpoint 
  Click on the Resume button 

in the Parallel Debug view 
  In this example, the three 

worker processes have hit the 
breakpoint, as indicated by 
the yellow process icons and 
the current line marker 

  Process 0 is still running as its 
icon is green 

  Processes 1-3 are suspended 
on the breakpoint 
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Module 5 

More On Stepping 
  The Step buttons are only 

enabled when all processes 
in the active set are 
suspended (yellow icon) 

  In this case, process 0 is still 
running 

  Switch to the set of 
suspended processes (the 
workers set) 

  You will now see the Step 
buttons become enabled 
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Module 5 

Breakpoint Information 

 Hover over breakpoint icon 
 Will show the sets this breakpoint applies to 

 Select Breakpoints view 
 Will show all breakpoints in all projects 
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 Use the menu in the breakpoints view to group 
breakpoints by type 

 Breakpoints sorted by breakpoint set (process 
set) 

Module 5 

Breakpoints View 
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Module 5 

  Apply to all processes and all jobs 
  Used for gaining control at debugger startup 
  To create a global breakpoint 

  First make sure that no jobs are selected (click in white 
part of jobs view if necessary) 

 Double-click on the left edge of an editor window 
 Note that if a job is selected, the breakpoint will apply to 

the current set 

Global Breakpoints 
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Module 5 

Terminating A Debug Session 

  Click on the Terminate 
icon in the Parallel 
Debug view to 
terminate all processes 
in the active set 

  Make sure the Root set 
is active if you want to 
terminate all processes 

  You can also use the 
terminate icon in the 
Debug view to 
terminate the currently 
selected process 
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Module 6: Fortran 

 Objective 
 Learn what Photran is and how it compares to CDT 
 Learn how to create a Fortran MPI application 
 Learn about refactoring support 

 Contents 
 Overview of Photran 
 Module 3 redux (in Fortran) 
 Differences between Photran and CDT 
 Pointers to online documentation for Photran 
 Refactoring support 
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Ralph Johnson’s research group at UIUC used to meet at Pho-Tran… 



…which became the name of their Fortran IDE. 



Photran 
•  http://www.eclipse.org/photran 
•  Official Eclipse Foundation project; 

part of the Parallel Tools Platform (PTP) 
•  20,000 downloads/release (2007) 

•  Supports Fortran 77, 90, 95, and 2003 
•  Built on CDT; largely similar to it 

•  Primary contributor: UIUC 
•  Contrib’s from Intel, IBM, LANL, & others 
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Fortran 
Editor & 
Outline 
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Context- 
Aware 

Highlighting 
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CVS 
support 
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Debugging 
(GDB GUI) 
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Installing Photran 

   1. Download the lastest photran-master-xxxxx.zip 
from http://wiki.eclipse.org/PTP/builds/photran/5.0.0 
@SC09 Tutorial: use file provided 
   2. In Eclipse, click on Help > Install New Software... 
   3. Click on the "Add..." button. 
   4. Click on the "Archive..." button. 
   5. Choose the zip file you downloaded in step 1. 
   6. Click OK to close the Add Site dialog. This will 
return you to the Install dialog  to complete the 
installation. 
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Installing Photran (2) 

7. Expand "Photran (Fortran Development Tools)" and 
check the box next to "Photran End-User Runtime.” 

8. Click on the "Next" button.    
9. If you get an error message, see Photran's online 

documentation for troubleshooting information. 
10. Click the Finish button and agree to the license to 

complete the installation. 

http://wiki.eclipse.org/PTP/photran/documentation/
photran5#Installation_Procedure  
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Using Photran 

 It’s just like using CDT... 
 Similar New Project wizards 
 Similar build procedure 
 Similar launch/debug procedure 

 ...but not exactly 
 Configuring fixed vs. free form file extensions 
 Different editor features 
 Different advanced features (Module 7) 
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Switch to C/C++ Perspective 
 Only needed if 

you’re not 
already in the 
perspective 

 What Perspective 
   am in in? 
   See Title Bar 

Fortran 
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Creating a Fortran Application 

Steps: 
 Create a new Fortran project 
 Edit source code 
 Save and build 
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(same as Creating a C/C++ Application) 



New Fortran Project Wizard 

Create a new MPI project 
  FileNewFortran Project 

(see prev. slide) 
  Name the project   

‘MyHelloProject’  
  Under Project types, under 

Makefile Project,  select MPI 
Hello World Fortran Project 
and hit Next  

  On Basic Settings 
page, fill in information 
for your new project 
(Author name etc.) 
and hit Finish 

There are  
“Managed Build” 
projects for 
Fortran too… 

…but this is a 
Makefile project, 
where you 
maintain the 
Makefile 
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(similar to New C/C++ Project Wizard) 



Fortran Projects View 

 Represents user’s data 
 It is a set of user defined 

resources 
 Files 
 Folders 
 Projects 

 Collections of files and 
folders 

 Plus meta-data 

 Resources are visible in 
the Fortran Projects View 
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(similar to C/C++ Project Explorer view) 



Editor and Outline View 
  Double-click on 

source file to 
open Fortran 
editor 

  Outline view is 
shown for file in 
editor 
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Build 

  Your program should build when created. 
  To rebuild, many ways include: 

  Select project, Hit hammer icon in toolbar 
  Select project, Project  Build Project 
  Right mouse on project, Clean Project 
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Et Cetera 
 Creating a launch configuration is identical 

(Suggestion: Uncheck Stop on startup at main in the Debugger tab) 
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Et Cetera 

 Debugging is identical 

 Launching a parallel application is identical 

 Debugging a parallel application is identical 
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Diagnosing Common Problems 

  Right-click on the 
project in the Fortran 
Projects view, and 
choose Properties 

  Expand Fortran 
BuildSettings 

  Switch to the Error 
Parsers tab 

  Are Photran’s error 
parsers checked?  If 
not, click Check all 

  Click OK and re-build 

Building: Are compile 
errors not shown in the 
Problems view? 
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(also true for C/C++) 

  Right-click on the 
project in the Fortran 
Projects view, and 
choose Properties 

  Expand Fortran 
BuildSettings 

  Switch to the Binary 
Parsers tab 

  Make sure the parser 
for your platform is 
checked 
    PE = Windows 
    Elf = Linux 
    Mach-O = Mac OS X 

  Click OK 

Launching: Is a binary 
not listed when creating a 
launch configuration? 



Differences (1): MPI Project Wizard 

 In the MPI Hello World C Project, 
the MPI compiler is set in the project settings… 
(See “Changing the C/C++ Build Settings Manually” in Module 3) 

 …but in the MPI Hello World Fortran Project, 
the MPI compiler is set in a Makefile. 
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Differences (2): Content Assist 

 Content assist is disabled by default. 
(So are Declaration View, Hover Tips, Fortran Search, and refactorings.) 
You must specifically enable it for your project. 

  Right-click on the 
project in the Fortran 
Projects view, and 
choose Properties 

  Expand Fortran 
Analysis/Refactoring 

  Check Enable Fortran 
analysis/refactoring 

  Click OK 
  Close and re-open any 

Fortran editors 
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Differences (3): Source Form 

 Fortran files are either free form or fixed form 
 Determined by filename extension 
 Extensions are set in the workspace preferences 

  Defaults: 

    Fixed form:  .f  .fix  .for  .fpp  .ftn 

    Free form:  .f03  .f95  .f90  .f77 

 Many features will not work if filename 
extensions are associated incorrectly 
(Outline view, content assist, Fortran Search, refactorings, Open Declaration, …) 
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Differences (3): Source Form 

  Navigate the tree 
to General 
Content Types 

  Expand Text 
Fortran Source 
File 

  Select Fixed or 
Free Format and 
set associations 

Set fixed/free form filename extensions in the preferences 

Module 6 6-24 



Differences (3): Source Form 
Outline view displays expected source form of file in editor 

(according to the workspace preferences) 

Attempting to open a file 
with the “wrong” editor 
(right-clickOpen With) 
issues a warning 
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For More Information 

 Photran online documentation 
linked from http://www.eclipse.org/photran 

 User’s Guide 
General introduction, basic features 

 Advanced Features Guide 
Features requiring analysis/refactoring to be enabled 

 Online tutorial: Compiling and running the 
Parallel Ocean Program using Photran and PTP 
linked from http://wiki.eclipse.org/PTP/photran/tutorials 
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Refactoring 

  Refactoring is the research 
motivation for Photran @ Illinois 
  Illinois is a leader in refactoring research 

  “Refactoring” was coined in our group 
(Opdyke & Johnson, 1990) 

  We had the first dissertation… 
(Opdyke, 1992) 

  …and built the first refactoring tool… 
(Roberts, Brant, & Johnson, 1997) 

  …and first supported the C preprocessor 
(Garrido, 2005) 

  Photran’s agenda: refactorings for HPC, 
language evolution, refactoring framework 

  Photran 5.0: 10-15 refactorings 

(making changes to source code that don’t affect the behavior of the program) 
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In Java (Murphy-Hill et al., ICSE 2008): 

Rename Refactoring 
 Changes the name of a variable, function, etc., 

including every use 
(change is semantic, not textual, and can be workspace-wide) 

 Only proceeds if the new name will be legal 
(aware of scoping rules, namespaces, etc.) 

  Select Fortran Perspective 
 Open a source file 
  Click in editor view on 

declaration of a variable 
  Select menu item 

RefactorRename 
 Or use context menu 

  Enter new name 
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  Moves statements into a new subroutine, replacing the 
statements with a call to that subroutine 

  Local variables are passed as arguments 

Extract Procedure Refactoring 

  Select a sequence of statements 
  Select menu item 

RefactorExtract Procedure… 
 Or use context menu 

  Enter new name 
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  Fortran does not require variable declarations 
(by default, names starting with I-N are integer variables; others are reals) 

  This adds an IMPLICIT NONE statement and adds explicit 
variable declarations for all implicitly declared variables 

Introduce IMPLICIT NONE Refactoring 

  Introduce in a single file by 
opening the file and selecting 
RefactorIntroduce IMPLICIT 
NONE… 

  Introduce in multiple files by 
selecting them in the Fortran 
Projects view, right-clicking on 
the selection, and choosing 
RefactorIntroduce IMPLICIT 
NONE… 
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Module 7: Advanced Development 

 Objective 
 Become familiar with other tools that help 

parallel application development 

 Contents 
 Parallel Language Development Tools: MPI, OpenMP, UPC 

 Special Tools for parallel development  
 Performance Tuning and other external tools:  

 PTP ETFw, TAU, PPW  
 MPI Analysis: ISP 
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Parallel Lang. Dev. Tools 
 PLDT Features 

 Analysis of C and C++ code to determine the location 
of MPI, OpenMP, and UPC Artifacts 

 Content assist via ctrl+space (“completion”) 
 Hover help  
 Reference information about the API calls via Dynamic 

Help 
 New project wizard automatically configures managed 

build projects for MPI & OpenMP 
 OpenMP problems view of common errors 
 OpenMP “show #pragma region” , “show concurrency” 
 MPI Barrier analysis - detects potential deadlocks 

Some MPI features were covered in Module 4 
Note: Most PLDT features in 3.0 don’t work on remote (RDT) projects 
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Added by PLDT (Parallel Lang. Dev. Tools) 
feature of PTP 

 MPI Context sensitive help 
 MPI artifact locations 
 MPI barrier analysis 
 MPI templates 

 For this part, we will use the MPI New Project 
Wizard and the “MPI Hello World” project 

MPI Assistance Tools 
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Create MPI Project 

 File > New > C 
Project 

 Give Project a 
name, e.g. 
HelloMPI 

 Select MPI Hello 
World C Project 

 Click Finish 
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Set MPI Preferences 
  When creating MPI 

project for the first time, 
you will be asked to set 
MPI Preferences 

  Select Yes. 
  On the MPI Preferences 

page, add a new MPI 
include path. 

  New … and point to the 
directory containing 
your MPI header file 

  Select OK 
  Back on New Project 

Wizard page, select 
Finish. 

  You can also set 
preferences at any time 
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Create MPI Project 
  File > New > C Project 
  Give Project a name, 

e.g. HelloMPI 
  Select MPI Hello World 

Project 
  Click Finish 

  Helpful editor features: 
  Hover over MPI API 
  Code completion 

(Ctrl-space) 
  Help (see next slide) 
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Show MPI Artifacts 
  Select source file; Run 

analysis by clicking on 
drop-down menu next 
to the analysis button 
and selecting Show 
MPI Artifacts 

  Markers indicate the 
location of artifacts in 
editor 

  In MPI Artifact View 
sort by any column 
(click on col. heading) 

  Navigate to source code 
line by double-clicking 
on the artifact 

  Run the analysis on 
another file and its 
markers will be added to 
the view 

  Remove markers via  
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MPI Barrier Analysis 
Verify barrier 
synchronization in C/
MPI programs 

Interprocedural static 
analysis  outputs: 

 For verified programs, 
lists barrier statements 
that synchronize 
together (match) 
  For synchronization 
errors, reports counter 
example that illustrates 
and explains the error  
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MPI Barrier Analysis – Try it 
Add some barriers: 
  Inside the sample 
if(rank…) add a barrier: 
 Use Content Assist to 
help you type 
 Type: MPI_  and press 
Ctrl-space.  See 
completion alternatives. 
Keep typing until you 
see MPI_Barrier and hit 
enter. 
 For args, start typing 
MPI_Comm_  etc and it 
will also complete 
MPI_COMM_WORLD 
 Add the same barrier 
statement at the end of 
the else as well. 

Resulting statement 
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MPI Barrier Analysis – Try it (2) 
Run the Analysis: 
 In the Project Explorer, 
Select the source file (or 
directory, or project) of 
file(s) to analyze  

  Select the MPI Barrier 
Analysis action in the 
menu 
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MPI Barrier Analysis - views 

MPI Barriers view 

Simply lists the barriers 

Like MPI Artifacts view, 
double-click to navigate 
to source code line (all 
3 views) 

Barrier Matches view 
Groups barriers that 
match together in a 
barrier set – all 
processes must go 
through a barrier in the 
set to prevent a 
deadlock 

Barrier Errors view  

If there are errors, a 
counter-example 
shows paths with 
mismatched number 
of barriers  
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MPI Templates 

 Allows quick entry of 
common patterns in 
MPI programming 
 Example: MPI send-
receive 
 Enter: mpisr <ctrl-
space> 
 Expands to 

 Eclipse preferences: add more! 
 C/C++ > Editor > Templates 

 Extend to other common patterns 
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OpenMP Managed Build Project   

  If you haven’t set up 
OpenMP preferences e.g. 
include file location, do it 
now 

  Create a new OpenMP 
project 
  FileNewC Project 
  Name the project e.g. 

‘MyOpenMPproject’  
  Select OpenMP Hello World C 

Project 
  Select Next, then fill in other 

info like MPI project 
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Setting OpenMP Special 
Build Options 

  OpenMP typically requires  
special compiler options. 
 Open the project  

properties 
 Select C/C++ Build 
 Select Settings 
 Select C Compiler 

 In Miscellaneous,  
add option(s). 
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Show OpenMP Artifacts 

  Select source file, 
folder, or project 

  Run analysis 

  See artifacts  in 
OpenMP Artifact 
view 
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Show Pragma Region 

  Run OpenMP 
analysis 

  Right click on  
pragma in  
artifact view 

  Select Show  
pragma region 

  See highlighted region in C editor 
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Show OpenMP Problems 

  Select OpenMP 
problems view 

  Will identify standard 
OpenMP restrictions 
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OpenMP: Show Concurrency 
  Highlight a statement 
  Select the context menu 

on the highlighted 
statement, and click 
Show concurrency  

  Other statements will be 
highlighted in yellow  

  The yellow highlighted 
statements might execute 
concurrently to the 
selected statement 
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UPC Support 

  To see UPC support in C  
editor, install the optional  
feature from CDT 

  See Also: 
http://wiki.eclipse.org/PTP/other_tools_setup#Using_UPC_features 

  Filetypes of “upc” will 
get UPC syntax high- 
lighting, content assist, 
etc. 

  Use preferences to  
change default for *.c 
if you like 

Under Optional Features 
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More Advanced Features 

 ETFw – External Tools Framework and 
TAU, Tuning and Analysis Utilities 
 Wyatt Spear, U. Oregon  

 PPW – Parallel Performance Wizard 
 Max Billingsley III, U. Florida 

 ISP – In-situ Partial Order: 
         Dynamic Formal Verification for MPI 
 Alan Humphrey, U. Utah 
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PTP/External Tools Framework 
formerly “Performance Tools Framework” 

Goal: 
 Reduce the “eclipse plumbing”  

necessary to integrate tools 
 Provide integration for 

instrumentation, measurement, and 
analysis for a variety of performance 
tools 

  Dynamic Tool Definitions:  
Workflows & UI 

  Tools and tool workflows are 
specified in an XML file 

  Tools are selected and configured in 
the launch configuration window 

  Output is generated, managed and 
analyzed as specified in the 
workflow 
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PTP TAU plug-ins  
http://www.cs.uoregon.edu/research/tau 

  TAU (Tuning and Analysis Utilities) 
  First implementation of External Tools Framework 
  Eclipse plug-ins wrap TAU functions, make them 

available from Eclipse 
  Compatible with Photran and CDT projects and with 

PTP parallel application launching 
  Other plug-ins launch Paraprof from Eclipse too 
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Initial Goal: TAU Integration 

 TAU: Tuning and 
Analysis Utilities 
 Performance data 

collection and analysis 
for HPC codes 

 Numerous features 
 Command line interface 

 The TAU Workflow: 
 Instrumentation 
 Execution 
 Analysis 
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ETFw Motivation 

 There are numerous command-line oriented 
development tools employed in HPC 

 These can be complicated or time consuming 
to use 

 IDE integration for individual development 
tools is slow and inconsistent 

  We want all our development tools in one 
place with one interface 

 We want our development tools to work 
together 
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ETFw: Development Tool 
Workflows 

 Variations on ‘Compile, Execute, Analyze-
Results’ are common to most software 
development 

 These steps may be tedious and time 
consuming, especially over multiple iterations 

 By defining both tool interfaces and behavior 
in an XML document these steps can be 
simplified and automated 
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ETFw: The Build Phase 

 Set compilers and arguments for each language 
 Define UI for compiler/compiler-wrapper 

configuration 
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ETFw: The Execution Phase 

 Specify composed execution tools such as 
Perfsuite or Valgrind 

 Set launch environment variables 
 Define variables and tool options in XML or 

provide a UI in the IDE 
 Integrates with PTP parallel launch 

environment 
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ETFw: The Analysis/Post-
Processing Phase 

 Sequentially run 
tools on program 
output 

 Launch external 
visualization tools 
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ETFw: XML-Defined UI 
Components 

 Each pane constructs a set of options 
sent to a tool or a set of environment 
variables 

 Numerous options for converting a 
command line interface into an 
intelligent GUI without Eclipse coding 
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ETFw: Advanced Components 

 Extension points 
allow integration with 
UIs and workflow 
behavior too complex 
to define in XML 

 Logical and iterative 
workflows for 
successive executions 
and parametric 
studies 
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ETFw: Using Workflows 

 New workflows are 
added to the ETFw 
launch configuration 
system 

 Multiple workflow 
configurations can be 
defined and saved for 
different use cases 

 XML Workflow 
definitions can be saved 
and reused in different 
environments 
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ETFw: General Purpose Workflow 

 Automated 
 Generalized 
 Quick performance 

analysis and other 
development tool 
integration 

 Exposes tool 
capabilities to the user 
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ETFw: Continuing Development 

 Integration with PTP Remote Development 
Tools 

 Additional options for GUI definition 
 Generalization of TAU specific features such as 

hardware counter selection and performance 
data storage 

 Contact: Wyatt Spear 
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Parallel Performance Wizard (PPW) 
  Full-featured performance tool for 

PGAS programming models 
  Currently supports UPC, SHMEM, and 

MPI 
  Extensible to support other models 
  PGAS support by way of Global Address 

Space Performance (GASP) interface 
(http://gasp.hcs.ufl.edu) 

  PPW v2.1 features: 
  Easy-to-use scripts for backend data 

collection 
  User-friendly GUI with familiar 

visualizations 
  Advanced automatic analysis support 

  More information and free 
download: http://ppw.hcs.ufl.edu 
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  We implement the ETFw to make 
PPW’s capabilities available within 
Eclipse 
  Compile with instrumentation, 

parallel launch with PPW 
  Generates performance data file in 

workspace, PPW GUI launched 

  PPW is often used for UPC 
application analysis 
  ETFw extended to support UPC 
  Many UPC features in PTP 

  For more information: 

 http://ppw.hcs.ufl.edu 
 ppw@hcs.ufl.edu 

PPW Integration via ETFw 
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ETFw Feedback view 

 New view to show externally acquired info e.g. 
from compilers and performance tools via 
XML, and map to source code lines. 

 New extension point for customization 
 New to PTP 3.0 
 Examples: 

 Compile optimization report: optimizations that were 
made, and could not be made 

 Performance tool data includes recommendations 
mapped to source code lines 
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ETFw Feedback view 
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 Easy navigation to source code lines 



  Many existing tools provide 
information that can be mapped to 
source code lines 
  Compiler errors, warnings, 

suggestions 
  Performance tool findings 

  ETFw feedback view provided to aid 
construction of these views 
  Currently geared toward data 

provided by tools in XML files 
  Existing ETFw facilities aid the CALL of 

external tools from PTP 
  Feedback view aids the exposition 

of results to the user 

ETFw Feedback view 
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ISP – In-situ Partial Order 

 Dynamic verifier for MPI applications, to detect 
 Deadlocks 
  Assertion violations 
 MPI object leaks 

 Contributed to PTP by the University of Utah 
  Available in PTP 3.0 (late Nov.) 

 Offers rigorous coverage guarantees 
  Rigorous coverage of communication/synchronization behaviors 
 Determines relevant interleavings, replaying them as necessary 

 Tested on several different MPI implementations 
 MPICH2, OpenMPI, Microsoft MPI,  MVAPICH, and IBM MPI  
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ISP - Dynamic Formal Verification for MPI 

                          (Image courtesy of  Steve Parker, U of  Utah) 

•  Recommended best use of ISP 
 is during application development 

•  Automatically instruments and 
runs user code, displaying results 

•  A variety of GUIs facilitate 
debugging and code understanding 
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ISP Success Stories 
 Umpire Tests  

  http:// www.cs.utah.edu / fv / ISP-Tests 
 Documents bugs missed by tests, caught by ISP 

 MADRE (EuroPVM/MPI 2007) 
  Previously documented deadlock detected 

 N-Body Simulation Code 
  Previously unknown resource leak caught during  
   EuroPVM/MPI 2009 tutorial ! 

 Large Case Studies 
  ParMETIS, MPI-BLAST, IRS (Sequoia Benchmark), and a few 

SPEC-MPI benchmarks could be handled 

 Full Tutorial including LiveDVD ISO available 
  Visit http:// www.cs.utah.edu / fv / ISP-Release 
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Eclipse CDT/PTP based ISP GUI  
 ISP Plug-in uses Eclipse CDT and PTP  
 Highlights Bugs, and facilitates 
 Post-Verification Review / Debugging 

 The MPI Happens-Before Graph 
shows required orderings and 
communication matches 

  Download / documentation:      http:// www.cs.utah.edu / fv / ISP-Eclipse   
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ISP Analyzer View 
 Reports program errors, and runtime statistics 
 Debug-style source code stepping of interleavings 

 Point-to-point / Collective Operation matches 
 Internal Issue Order / Program Order views 
 Rank Lock feature 

 One click to visit the Eclipse editor, to examine: 
 Calls involved in deadlock  

 helps root-cause deadlock 

 MPI Object Leaks sites 
 helps root-cause leaks 

 Assertion Violations 
 takes view to failing assertion 
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Running ISP 
 Create an MPI C Project within C/C++ Perspective 

 Make sure your project builds and runs correctly 

 Set preferences and via ISP Preference Page 
 From the trident icon or the ISP menu, user can: 

 Context menus may also be used from Project Explorer 

 Formally Verifying MPI Program  
 Launches ISP 
 Generates log file for Post-Verification Analysis Views 

 Dedicated ISP Console accompanies Analyzer View 
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ISP Integrated Help 
Extensive graphical aids & trouble shooting section 
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PTP Adv. Development: Summary 

 A diversity of other tools aid parallel development 
 Parallel Language Development Tools: MPI, OpenMP, UPC 

 MPI Barrier deadlock detection, etc. 
 External Tools Framework (ETFw) eases integration of 

existing (command-line, etc.) tools 
 TAU Performance Tuning uses ETFw 
 PPW (Parallel Perf. Wizard) uses ETFw for UPC analysis 
 New Feedback view maps tool findings with src code 

 MPI Analysis: ISP 

 A diversity of contributors too! 
 We welcome other contributions. Let us help! 
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Module 8: Other Tools and 
Wrap-up 

 Objective 
 How to find more information on PTP 
 Learn about other tools related to PTP 
 See PTP upcoming features 

 Contents 
 Links to other tools, including performance tools 
 Planned features for new versions of PTP 
 Additional documentation 
 How to get involved 
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NCSA 
HPC Workbench 

  Tools for NCSA Blue Waters 
  http://www.ncsa.illinois.edu/BlueWaters/ 
  Sustained Petaflop system 

  Based on Eclipse and PTP 
  Includes some related tools 

 Performance tools 
 Scalable debugger 
 Workflow tools (https://wiki.ncsa.uiuc.edu/

display/MRDPUB/MRD+Public+Space+Home
+Page) 

  Part of the enhanced computational environment 
described at:  
    http://www.ncsa.illinois.edu/BlueWaters/ece.html 
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NCSA HPC Workbench Coding & 
Analysis 

(CDT, PLDT, 
Photran) 

PTP Debugging 

PTP  
Launching & 
Monitoring 

Performance 
Tuning 

(HPC toolkit,  
HPCS toolkit,  

RENCI, …) 

Workflow 
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Useful Eclipse Tools 

 Python 
 http://pydev.sourceforge.net 

 Ruby 
 http://sourceforge.net/projects/rubyeclipse 

 Subversion (now an Eclipse project) 
 http://eclipse.org/subversive 
 Or Subclipse: http://subclipse.tigris.org/ 

 Git (now an Eclipse project) 
 http://www.eclipse.org/egit 

 … and many more! 
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Future PTP Features 

 Support for multicore development 
  Building on Cell IDE and other multicore tools 

 Resource managers to support for PBS, LSF, 
and Blue Gene 

 Transitioning debugger to Scalable Tools 
Communication Infrastructure (STCI) 

 Scalability improvements 
  UI to support 1M processes 
  Optimized communication protocol 
  Very large application support 
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Online Information 

  Information about PTP 
 Main web site for downloads, documentation, etc. 

 http://eclipse.org/ptp 
 Developers’ wiki for designs, planning, meetings, etc. 

 http://wiki.eclipse.org/PTP 
  Articles and other documents 

 http://wiki.eclipse.org/PTP/articles 

  Information about Photran 
 Main web site for downloads, documentation, etc. 

 http://eclipse.org/photran 
  User’s manuals 

 http://wiki.eclipse.org/PTP/photran/documentation 
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Mailing Lists 

  PTP Mailing lists 
 Major announcements (new releases, etc.) - low volume 

 http://dev.eclipse.org/mailman/listinfo/ptp-announce 

  User discussion and queries - medium volume 
 http://dev.eclipse.org/mailman/listinfo/ptp-user 

 Developer discussions - high volume 
 http://dev.eclipse.org/mailman/listinfo/ptp-dev 

  Photran Mailing lists 
  User discussion and queries 

  http://dev.eclipse.org/mailman/listinfo/photran 

 Developer discussions – 
  http://dev.eclipse.org/mailman/listinfo/photran-dev 
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Getting Involved 

 See http://eclipse.org/ptp 
 Read the developer documentation on the wiki 
 Join the mailing lists 
 Attend the monthly developer meetings 

 Teleconference each second Tuesday, 1:00 pm ET 

 PTP will only succeed with your participation! 
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Thanks for attending 
We hope you found it useful


PTP Tutorial Feedback 

 Please complete feedback form 
 Your feedback is valuable! 
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